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About this manual
This manual is designed to cover the use of the MassTracker software from the Ohaus Corporation.

This manual may be copied for use within the premises of the licensee on condition that it is not loaned, sold
or used outside the Licensee�s premises.

Copyright: all rights reserved
Ohaus Corporation policy is to continually improve products and services, so we reserve the right to make
changes without notice.  It is acknowledged that there may be errors in this publication for which responsibility
cannot be assumed.  No liability will be accepted for loss or damage resulting from use of information con-
tained in this manual or from uses as described.
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Introduction
What is MassTracker ?
MassTracker is a software program designed to work with an RS232 equipped Ohaus balance and is used to
collect and plot data continuously or selectively.  The program can automatically plot mass data in line, point
or bar graphs in a real time mode.  There are two main components of the MassTracker software; MassTracker
and Workroom.

Features and Capabilities
Menu functions � Save and open data files and graphs.

� Print and copy graphs and tables.
� Save and recall setups for experiments and balance settings.

Display Options � Zoom, autoscale, set axis limits, select intervals of data.
Analysis Options � View specific values and time intervals along recorded plot, calculate area under

the curve, view gradients (rate of change) at selected points.
Tools Options � Smooth, add text to graphs, erase data sets, apply mathematical functions to

recorded data and generate new plots with the Function Wizard.
Overlay Mode � Overlay multiple trials onto one graph.
Data/File Storage and � Data tables stored as text files can be imported into popular spreadsheets pro-
transfer capability grams.

� Graphs can be saved as metafiles.
� Data or graphs can be copied and pasted into Windows applications.

MassTracker

Workroom

This program is used for recording and graphing of mass data from an Ohaus balance.  There are
facilities for analyzing data and for the creation and retrieval of preset experiments.

The purpose of the Workroom is to select, organize and import preset experiment files.  These experi-
ments can be created by the user, or examples obtained from Ohaus Corporation. The HTML files
displayed by Workroom can be loaded into a word processor and then customized by the user.

IMPORTANT NOTES:
1. When using Ohaus balances with MassTracker, insure that the RS232 feature has been enabled.  Some

balances have this feature initially disabled to conserve power usage.  For further information, please refer
to the Instruction manual of your particular balance.

2. Some balances make use of a �Print Stable Data Only� option.  This will prevent RS232 output when the
balance detects an unstable reading.  Because MassTracker requires that the balance always be able to
print, this option must always be disabled.  If MassTracker detects a non-printing condition, the active
Trial will be stopped and an error message will be displayed.  An example of product that may have the
�Print Stable Data Only� option initially enabled would be an Ohaus Adventurer balance.  For further infor
mation, please refer to the Instruction manual of your particular balance.
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Installation
Minumum Requirements
Before installing and using the MassTracker software, you will require:

- Any RS232 equipped Ohaus balance
- Ohaus compatible Serial Cable such as AS017-09 or AS017-02
- IBM PC (or compatible) - PentiumTM 75Mhz
- WindowsTM 95, 98, NT, 2000
- RAM - equivalent to minimum as required by operating sysytem
- 5 MB of free Hard Disk space
- One free RS232 Serial Port

Optional
- HTML viewer such as MS Internet ExplorerTM 3.0, Netscape NavigatorTM 3.0, or newer versions.
- A WindowsTM compatible color printer.

All other trademarks are the property of their respective owners.

Installing MassTracker Software
From the taskbar, click on START - Run
Use the Browse button or type A:\Setup , press <Enter> or select �OK�.
Follow the on-screen prompts to install the program.
Insert disk 2 when prompted.
NOTE: Some operating systems may not require the installation of disk 2.
The desktop on your computer should now display two new Icons, one is MassTracker, the other is Work-
room.  Each program can be started by clicking on the appropriate Icon.

NOTE: Please make backup copies of the disks as soon as possible.

Connecting the Interface
Connect one end to the serial port of the balance and the other to the serial port of the computer.  For interface
cables with two similiar connectors, the balance end is marked for identification.  Note which serial port you
have connected on the computer i.e. COM1, COM2, COM3 or COM4 as this information is required when you
first start the software.

The first time MassTracker is run, an interface option window may
appear.  The currently available interface options will be shown.  If the
selected port is different from the one you have connected to, select the
correct port from the menu.

� Using the File menu in MassTracker, select Serial Port.
� Select the correct serial port i.e., COM1, COM2, COM3 or COM4.

During operation, the communication port can be changed as follows:

NOTE: The fixed serial communication parameters which must be used are shown under the serial port selections.  These corre-
spond to Ohaus balance default parameters.
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Opening the MassTracker Program
� To open the program, double click the MassTracker Icon 

MassTracker
� A second method of opening the program: Click on the Start button on the Windows taskbar.

Within Programs, select Ohaus MassTracker, then select MassTracker.

� A third method: If experiment files have been saved on the Desktop view, double clicking the experiment
Icon will also start MassTracker.

MassTracker at a Glance
To become familiar with the MassTracker program, it is recommended that a preliminary graph be created
and analyzed.  Below are simple steps that can be used to create such a graph.  A detailed description of all
functions can be found in this manual.
� Click on the Recording Wizard Icon located at the bottom of the screen
� Use the preset recording time span or change to a preferred time span.
� Adjust the Y -axis limits as desired.
� Click on Finish.
� Press the Start/Stop button to begin recording.
� Finish by again pressing the Start/Stop button or waiting for the test time to be completed.
� When finished, the following options are available for changing the look of the graph and performing result

analysis.
� DISPLAY - contains options that allow user to change the look of the graph and the toolbars.
� ANALYSIS - contains options for analyzing the finished graph.
� TOOLS - contains features for advanced analysis as well as options for adding graph details.

The MassTracker Screen

Information
Window

Display
Options

Analysis
Options

Tools
Options

Graph Display WindowActive Trial Indicator

Data Bar

Start/Stop
  Button

Pause
Button

Menu Bar ➤
Data Value Boxes ➤

Show / Hide
Check Box

➤

Customizable
Toolbar ➤

Window
Divider

➤

➤
Data
Table
Window

Recording
Wizard
(New)

➤
➤ ➤ ➤ ➤ ➤

➤

➤

➤

➤
➤

Currently
Loaded
Setup
File
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The Graph Display Window
The Graph Display Window is where readings are displayed and contains the tools needed to set up, collect
and analyze data.

The Data Table Window
The Data Table Window is where the tabulated data from each trial is displayed.

Customizing the Data Table
To adjust a single column, position the cursor between column headings, click, hold down, and drag to adjust
the width.

The horizontal position of each column can also be altered.  Click on the column heading, hold down and
drag to its new position.

To adjust the width of the data table window, position the cursor
over the window divider to the left of the graph window section.
When it becomes a <II> symbol, click, hold down the mouse
button, and drag to the right or left to adjust.

<   >

Recording Buttons
Start icon
To begin recording, simply click on the Start icon.

Stop icon
During data recording, the Start icon will change to a Stop icon.
Click on the Stop icon to stop data from being recorded before the selected duration has passed.

Pause icon
During data capture, it is possible to pause the display.  Click on the pause icon, the screen is �frozen�
but the recording will continue unseen on the screen.  Click on the Pause button again to cancel the
freeze and display the hidden graph.

NOTE: The Predict tool becomes available only when the active trial is paused.

The data value box displays the data as it is being recorded during a trial.  In the overlay
mode, up to seven trials may be run in sequence, each will have their own data value
box.  The top of the box defines the Trial name.  The bottom of the box indicates the
measuring unit as it was received from the balance.  For example, this could be  g for
grams, oz for ounces, lb for pounds, etc...

The color of the trial name and unit corresponds to the plotted data of the same color.

The Data Value Boxes

<II>
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Each data trial is allocated a different color.  If the overlay mode has been selected, multiple trials are placed
on a single graph.   You may then compare one trial against another.  When a color printer is used, overlaid
trial headings shown at the top of the graph will print in the appropriate color matching the corresponding
plotted data.

The Data Value Boxes (Cont.)

Data in the graph window can be hidden or displayed by
clicking in the small box under the data window.  A check
mark in the box indicates that the trial is displayed.

Editing Trial Names
The Trial Names at the top of each column of the data table may be edited by holding the Shift key and click-
ing in the appropriate Data Value box.   When this is done an �Edit Trial Name� window will open.  Edit the
Trial name as needed and select OK.

Active Trial Indicator
The Active Trial Indicator is located in the top left corner of the graph window.  This indicator shows which
data set is presently active in the graph window.  When program options are selected, only the active trial is
affected.  To change the active trial, click on the active trial text, this advances to the next available trial.

Recording Wizard (New)

The Recording Wizard is the first step in starting a �New�
trial.  If a previous trial is displayed, a prompt to save the
previous trial appears.  If �NO� is selected, the previous
trial is erased.  The Recording Wizard is also available
under the File menu.  Click on the Recording Wizard
button, the Recording Wizard will open.

Timespan
Select a suitable recording duration from the  available list.  The recording time range is from 30 seconds with
a fixed time sampling intervals of 0.5 second to 31 days with a fixed sampling interval of 1 hour.  Last
timespan selected is stored in memory for next use.

NOTE: Changes in Timespan mode may change settings of Display Wizard, check settings and readjust as needed.

Continuous
If selected, the recording will continue until stopped by clicking on the Stop icon.  The graph will begin with the
selected time-span and when this time has elapsed, the timespan will double continuously.
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Snapshot mode
In this mode there are no fixed recording intervals.  Each time you click in the graph area, the current
value for the balance is recorded and displayed.
NOTE:  Selecting Snapshot mode will affect the default settings in Display Wizard.   �Reading Number� and �Plot as bar� will
be selected.  Options in the Display Wizard can later be changed if desired.

Recording Wizard (cont.)

Start Condition
Provides two choices:  None and When mass...
When selected �When mass� provides a choice
of: Falls By, Rises By, Equal to or Greater
Than, Equal to or Less than.  This refers to the
mass value which can be specified in the
window to the right.  By clicking in this
window, you can specify a mass value.  This
option will hold off the start of recording until the
selected condition is met.

Y-Axis Limits
Allows you to set the Y-axis limits in measuring units.

Finish
When all settings have been made, clicking on this button will save your settings and enable a new test.

Display Options

Display Wizard
There are three methods to open the display wizard, using the File
menu, clicking on the Display option button and selecting Display
Wizard, clicking the Display Wizard tool bar button.

There are at least two methods available to select a display option.  One is to
select the option after clicking one of the three buttons at the bottom of the
screen.  Another method is to directly select the option from the Toolbar if it is
enabled.  Some of the options are also available under the File menu.

Display    

Display Wizard
Zoom
Auto Scale
Adjust Y axis limits...
Use selection
Show Toolbar
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Select Display Type
Allows data to be displayed as Line,  Points, or as a Bar graph.  Setting is saved upon exiting.

Options
Options include:

1. Placing a light grid over the graph area.
2. Enabling or disabling data table window.
3. Activating overlay mode to allow multiple trials to be run without the previous data being erased.

NOTE: A maximum of seven trials can be displayed on one graph.

Select X-axis
The X-axis can be set to show time intervals or sequential reading numbers.  Setting is saved upon exiting.

Finish
Click on Finish will save the selected options and close the Display Wizard.

Display Wizard (Cont.)

Zoom
Once data has been collected, an area of the graph can be magnified so that it can be seen in greater detail.

Click on the Zoom button.  Position the mouse pointer in a corner of the area to be magnified.  Using the left-
hand button of the mouse, click, hold down and drag a rectangular box over the area to be magnified.  Re-
lease the mouse button.  Repeat to increase magnification further.

Deselect Zoom to return to the original graph

Auto Scale
This option changes the y-axis limits to the minimum and maximum values of the data collected.  The scale
will be automatically set to the values of the data assigned to the vertical axis.

Position the mouse pointer to the left corner of the graph window where the Active Trial Indicator is shown and
click the left mouse button.  If you have multiple trials, each click of the mouse button will select the next
available trial.

Click on the Autoscale button.  The graph will be automatically adjusted to fit the screen.

To return to the original scale, deselect the Autoscale button.

Use Selection
Clicking on the Use Selection button will expand the graph showing only selected data.  To use this function,
more than one reading must have been previously selected.  To return to the original data, deselect the Use
Selection button.  Before using this option, data from the active trial must first be selected.
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Use Selection (Cont.)
How to Select Data

To select individual readings, click either the
reading in the table or a point on the graph.  The
reading will be highlighted in the table and marked
with a cursor line in the graph.  See illustration
below.

Individual Reading at 10 Seconds.

To select more than one series of readings, use the
SHIFT key to select a series of readings.  Hold down
both the SHIFT and CTRL key to select another
series of readings.  See illustration above.

More Than One Series of Readings.

To display just the series of readings, select the
Use Selection button.  The display will show just
the selected series as an expanded graph.  See
illustration to the right.

To deselect readings, click with the right button of
the mouse.

NOTE:  The Selection Wizard may also be used to select
data at fixed intervals. For more information, refer to the
section on Selection Wizard.

Multiple Readings from 10 to 15 Seconds.

Readings Not in Series.

To select readings that are not in series, hold down
the CTRL key and click on each reading or point in
turn.  See illustration below.

To select more than one reading in a series,  hold
down the SHIFT key, use the left-hand button of the
mouse to click, hold down and drag over the
readings to be selected.  See illustration above.

Just the Series of Readings



Ohaus Corporation

12

Customizing the Toolbar
To adjust the position of the Toolbar, (when enabled) click the right-hand button of the
mouse near the Toolbar, an alignment window will open.

To alter the position, select the position from the list.  When Align Bottom is selected, the
Toolbar is placed at the bottom of the screen.

The Toolbar can be customized to display the most frequently used buttons.  Click on the
Customize option and select or deselect the buttons
from the list displayed.

Align Left
Align Bottom

Customize...

Example of Toolbar Positioned to Left

To enable the toolbar, click the Display button, then click Show Toolbar.  If it is desired to eliminate the
Toolbar from the screen, click the bottom Display button, and again click near Show Toolbar to remove the
check mark.  Eliminating the Toolbar will provide more space on the screen for the graph and tables.

NOTE: When first turned on, only the Display
Wizard, Overlay mode, Adjust Y axis limits, Text,
Title, Test Mode, Erase Data and Function Wizard
Toolbar buttons are displayed.  Some Toolbar
buttons will not be active until data has been
collected.

Show Toolbar
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Analysis Options

Values

➤
➤

There are a number of tools that allow the analysis of captured data.  These are Values,
Interval, Area and Gradient.  The Toolbar may also contain analysis options. To select the
appropriate data trial, click anywhere in the selected trial box.

Select Values and move the mouse pointer into the graph
area.  A vertical line (cursor) will appear which can be
moved around the graph using the mouse.

Position the cursor at the point where information
from the data is needed.  The corresponding time and
mass value is highlighted in the Table and the
mass value is shown in the Data Value Box.

Click with the right-hand button to deselect.

Interval
Select Interval and click on a point in the graph to
produce a fixed vertical cursor.  Hold down the
mouse button and drag (a second vertical cursor will
continue to follow the mouse movement) to a second
point on the graph.  Release the mouse button and a
box will be drawn around that section of the graph
and the values selected will be highlighted in the
table.   Values in the data box reflect the starting and
ending points.

Display    Analysis     Tools

Values
Interval
Area
Gradient
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This feature is used to calculate and display the �area
under the curve� of a chosen section of the graph.

Select Area and click.   Hold down and drag the
mouse across the appropriate section of the graph.
Lines will appear to mark the section and the values
selected will be highlighted in the table.

The calaculated value for the area marked is shown in
the information box.  The unit assigned to this value is
the product of x � y, the vertical and horizontal axes.

Click with the right-hand button to deselect.
➤

This feature calculates the �rate of change� of data in
the vicinity of the cursor.  The calculation is performed
over three points centered on the cursor, therefore, a
plot must have at least three data points.  The gradient
line will only track within one data point of the start or
finish of a plot.

➤

Area

Gradient

To use the gradient analysis, select Gradient and a
small straight line will appear to indicate the slope of
the graph.  As the cursor is moved across the screen, a
small straight line will follow the gradient of the
graphed line.

Gradient information includes Date, Time and Rate
of change in mass units per second.

Click with the right button to deselect.

NOTE: On data that contains abrupt changes, the gradient
calculation may be unable to obtain an accurate value.  To
improve reading, use the Smooth feature from the Tools options.

Analysis Options (Cont.)
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Display    Analysis     Tools

Predict
Smooth
Text
Title
Erase Predictions
Test Mode
Erase Data Set...
Selection Wizard...
Function Wizard...

Smooth is used to �even out� the data of a selected line by applying a moving average.  Select the appropriate
Trial by clicking near the Activel Trail Indicator.  Select Smooth and a small window will appear on the graph.

Click on the > button to smooth or < to reverse the process.  The smooth level advances at one unit at a
time for the > symbol and 5 units for the >> symbol.  Close the window when the desired level is achieved.
The graphs below indicate before and after smoothing of a graph.  It should be noted that once the graph is
saved, you can go back and restore the original graph by resetting with the < button.

Original Graph.       Graph Smoothed.

Tools Options
Predict
Predict can only be used when an active trial is �Paused�.  When predict is selected,
a movable line will be attached to the last data point.  A left mouse click will fix the
end point of the �Predict� line.  Additional clicks will continue the line.  Use a right
click to finish.  To view if the prediction was correct, click the Pause button again to
reveal the actual data.  Use the Erase Prediction option to remove the predict lines.

Smooth

Used to annotate the graph with �text boxes�.  To place a text
box, ensure that the graph is stopped or paused.  Select Text,
move the cursor to the exact area of the graph line where you
want the text box to point to and click.  Type in the required
text and click on OK.

Text

A �ghost� rectangular box will appear, move it to the required
position.  While Text is selected, the label can be moved again
by  clicking and dragging to desired position.

The text can be edited or deleted.  With Text still selected, hold
down the SHIFT key and click on the appropriate label.  Click the
the right button of the mouse to deselect.

NOTE: This graph illustrates one text box in place
and a second being prepared.
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To add a title to the top of the graph, select Title and the Edit title
window will open.  Type in the text required for the title and select OK.

To alter or modify the present title, select Title and edit the title as required.  Press OK.

Title

Erase Predictions
Selecting Erase Predictions will allow the predict lines to be removed.  A new window will be displayed that
will allow selection of individual predict lines to be removed, (in cases where multiple predictions have been
made).

Tools Options (Cont.)

Before or after a trial, Test Mode may be selected. The Test Mode verifies that the program and the balance
have been set up correctly and serial communication has been established.  Place a mass on the balance pan
and observe the real time results in the Data Value Box located in the upper part of the screen.

If communication from the balance is not achieved, or stops, an error window will be shown and the Test
Mode will be exited.

NOTE: Only numeric information from the balance is shown in the Data Value Box.

Test Mode

To erase the entire data set, select Erase Data and the Erase Data Set
window will open.  Choose the data set to erase from the drop down menu.
Click on Delete Data Set to permanently erase the entire set of data from
that Trial.

NOTE: Erasing a data set will not affect trial names, but will resequence the trial colors.

Erase Data Set

Allows a user to select data readings at specified intervals e.g.
starting from the first reading, select every third reading.

Click on Selection Wizard from the Tools menu.  Select the desired
intervals then click on Select.  Vertical lines will appear on the
graph and the table will be highlighted according to your selection.

To deselect, click with the right button of the mouse.

NOTE: The data may also be manually selected.  See section �How to Select
Data.�  After data is selected, the �Use Selection� option may be used .

➤

Selection Wizard
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Having collected experimental data, it is sometimes useful to calculate a
new set of data derived from those results e.g. to calculate the difference
between two plotted mass changes.

Select Function Wizard and choose a formula from the function drop
down menu.  For example: ax - by.

Select the appropriate data trials from the x and/or y drop down menu.
For example:  x= (1) Trial 1, Y= Trial 2.

If required, enter values for the listed variables a, b, or c.
Type in the name and units for the derived data.

Select the number of decimal places to be shown in the table.

Click on Apply, the data is calculated in the data table, and a new plot will appear in the graph.  The function
will be assigned to the next available Trial number on the graph.

Use the maximum and minimum values to scale the axis for this data (or use Autoscale from the Display
Menu after the function has been applied).

If the result is too large or too small, or is off the visible graph area, the multiplier values, a, b, or c may be
adjusted to a more suitable number.  Click on Apply to revise the calculation.
Click OK to exit the Function Wizard.

The available functions are:

ax2 + bx + c a  sin(bx) + c ax + by a dx/dt
a/x + c a cos(bx) = c ax - by Average(x,a)
a/x2 + c a log(bx) + c axy a
a/(x^b) + c a exp(bx) + c ax/y

The values for:
x and or y can be �Time� in Seconds (s) or centisecond (cs), �Reading�, �Trial� or �Previous� function.
a, b, and c are constants for example a number or scalar,

NOTE: Use of Function Wizard requires the availability of a new data set.  Therefore, it is only available when a maximum of 6
previous data sets have been created.  Up to a maximum of 7 data sets are available.  Use Erase Data Set from the Tools menu or
Toolbar to delete data if required.

The Function Wizard

Tools Options (Cont.)
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The Function Wizard (Cont.)
(examples)
Average
Select the Function Wizard.

Select the function as Average (x,a), where x is the selected data
trial and a is the frequency of sampling e.g. if a=5, an average will
be calculated for each set of 5 samples.  Click on Apply.

To Place a Reference Line
One or more reference lines can be entered manually on the graph.

Select the Function Wizard.

Select function a, enter a value for a, where a = (y axis height).
Rename the column & enter the units as appropriate.  Click on
Apply.  A column filled with the a value will be created on the graph
as a straight reference line.

Double clicking on a cell in the data table will allow editing of single
data values.

Tools Options (Cont.)
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File Menu
The Menu bar gives you access to a number of options:  Click on File.

New � Used as an alternative method to open the Recording Wizard.
Open � Used to load previously saved graphs and table data.  Locate the

correct .sid file and click to open.
Save � Providing the file has been previously saved , the data will be

automatically saved again, retaining the name given the first time it
was saved.

Save As � A dialog box will open to allow the captured data to be saved
using a filename and destination of your choice.  Files are saved in
.sid format.

Save Used � Used to save a selection of the collected data.  Select the data required from the Table or Graph
Selection Window.  See section on �How to Select Data� Click on Use selection and the display will
As change to use only the data selected.  Select Save Used Selection As and a dialog box

will open to allow the captured data to be saved using a file name of your choice.  Files are
saved in .sid format.

Notes: 1. This option will not be available until the Use Selection option has been used.

 2. Files saved in .sid format can be loaded into any program  able to load text files or CSV (comma
separated values) files.  Files contain information about units and measurement to allow free
exchange of data between a variety of data logging software systems.

Save Meta � To save an image of the current Graph Window in .emf format (enhanced meta format).
File

Note:         Enhanced Meta Files - .emf format can be loaded into most Windows text and graphics programs.
Use this option to save a picture of the current Graph Window so that it can be inserted into a word-
processing report.

Print Graph� To print out a copy of the current graph window.

Print Table� To print out a copy of the current data table window.
Note:         Approximately 60 samples are printed per page, i.e. if 1000 samples are collected, a table would

use 19 pages to print.
Print Setup � To set up the print output to suit your printer.

Setups � To open an existing setup, save the current setup, launch the Work
room, or balance setup options.  Recording Wizard and Display
Wizard are also available.

Open Setup � When selected, an Open file window appears, which allows selec-
tion of experiment setup files that contain setup information.  After
the new setup has been loaded,  the name of the new setup file is
shown in the top right of the graph window.
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Setup files are saved with the format: FileName.ogs,  (the default file name is Experiment).  A
new folder is also opened with the same name.  A default HTML file is stored in this new folder.
When the Workroom is used to load the setup file, this HTML file is displayed with a compatible
HTML viewer such as MS Internet Explorer.

This index.html file can be edited or replaced with one of your own html files giving detailed
instructions and graphics that can enhance the experiment.

Any .ogs files saved on the Desktop view can also be used to open the MassTracker program.
Using this method will not open the HTML graphic.

Reload Setups  Files � When selected, will reinstall all setups from the previously loaded experiment
setup file.

Load Setups Strings � When selected, will begin loading strings listed in the present Setup String menu
starting with initial �Setup String�.

NOTE: Graph settings will not be affected.

File Menu (Cont.)
Save Setup � When selected, opens SAVE AS window which permits saving of experiment setup files.

Recording Wizard �  Refer to the previous section on
 Recording Wizard.

Display Wizard �  Refer to the previous section on
   Display Wizard.

Setup Strings �  This menu allows the setup of
      specialized text strings to be sent to

the balance or the user.
Balance Setup Strings
There are three groups of setup strings:

� Strings Utilized before Clicking the Start Button
� Strings Utilized after Clicking the Start Button
� Print Query String

The use of setu strings are for advanced users and
those who require a higher degree of consistency and automation for their experiments.  Strings sent to the
balance can automate the setup and selection of various balance functions and weighing modes.  This auto-
mation can help reduce the liklihood of setup errors when repeating an experiment several times.

Setup strings sent to the balance make use of the standard RS232 commands that are available for most
Ohaus balances.  Comands are detailed in the Ohaus balance instruction manuals.

Setup strings sent to the user can provide additional instruction and also provided a brake point near the start
of the experiment when operator intervention may be required.
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File Menu (Cont.)
Format for Setup Strings
When entering commands into the Setup Strings, the proper format must be used in order for the command to
be recognized.  The command structure is:

Command characters = RS232 commands from Ohaus Instruction manual
symbol set for a carriage return = �\r�
symbol set for a line feed = �\n�
delay command = �,�

Example:   T\r\n,

The above example will tare the balance.  T is a Tare command, \r is a carriage return, and \n is a line feed.
The comma at the end of the command string adds a half second delay to insure that any following com-
mands are read properly.  Additional commas may be added if required to increase this delay.

Other RS232 Commands
Refer to the appropraite manual of your Ohaus balance for additional RS232 comands.

The list below shows examples of some RS232 commands.
Ohaus Scout & Adventurer Balance

? Displays current mode
T Tare, same effect as pressing zero
P Print display data

Ohaus Navigator Balance
? Displays current mode
xM Enables a specific weighing mode unit, where x (number) calls out the weighing unit.
T Tare command
xZ Set Auto Zero to �x�, where x = 0 to 3.  0=off, 1=0.5d, 2=1d, 3=5d

Serial Port �Selects the serial port to be used e.g., COM1, COM2,
COM3 or COM4.

Exit � To quit MassTracker.  You will be prompted to save the
file if you haven�t already done so.

Workroom � When selected, launches the Workroom program.  This is
covered in detail in the next section of this manual.

Edit Menu
Copy Graph� Used to copy the current Graph onto the clipboard from where it can then be pasted into other

applications.

Copy Table� Used to copy the current Table onto the clipboard from where it can then be pasted into  other
applications.
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Procedure for Creating Experiments
This procedure would normally be used by an instructor or by a user that needs to create experiments that will
be repeated at a later date.  All of the basic experiment setup options can be accessed using only the File -
Setups menu.

1. Open the MassTracker program

2. Select:  File � Setups � Recording Wizard

3. From within the Recording Wizard, select Recording type, Start Condition, and Y-axis limits as required.
Select �Finish�.
NOTE: If a working balance is not connected at this time a warning will be displayed.  It is not necessary for a balance to be
connected to create and save an experiment setup.

4. Select:  File � Setups � Display Wizard.

5. From within the Display Wizard, select Display Type, Options, and X-Axis type as required.  Select �Finish�.

6. Select:  File � Setups � Setup Strings.

7. The optional Setup Strings can be used to enhance and automate certain functions of the experiment.  Two
prompt strings can be utilized to send the user informative messages.  An output and return verification
string can be used to verify the proper operation and setup of the balance before the experiment begins.
Three separate command strings can be sent to the balance to setup and alter the operation of the balance
if needed.  (Refer to the individual instruction manual for the particular balance being used to view the
available RS232 command strings.)  Additional information relating to the use and timing of the strings is
shown below each entry box.

The list of Setup Strings can also be made non-alterable or non-viewable to control the security of the
original experiment.  (The Viewable and Alterable options are reset to their default settings if the experiment
is later saved under a new name.)

When the necessary Setup Strings have been entered select �OK�.

8. Select:  File � Setups � Save Setup.

9. A �Save As� window will open, enter a new file name for the experiment.  A �Save setup� file window will
open, enter a brief description of the experiment, select �OK�.  When the experiment is later listed using the
Workroom program both the description and the file name will be shown.

10.When the experiment is saved an additional file Folder is created using the same name as the experiment.
Into this Folder is placed a default HTML file that can later be edited to include additional instructions and a
pictorial representation of the experiment.  The HTML file is named �Index.html�.  An application such as
MS Word can be used to edit this HTML file.  After editing save the new HTML file into the same Folder
using the same file name.  If other graphic image files are used these will also need to be placed into the
same Folder.
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Procedure for Running Previously Stored Experiments
This procedure would normally be used by students to run experiments originally created by their instructor.
This procedure would also be used by other users who need to repeat a similar experiment several times or at
a later date.  The use of previously saved experiments help reduce setup times and insures repeatable results.

There are three basic methods to run a previously stored experiment.  One method utilizes an HMTL screen
that can display additional instructions and a complete pictorial representation of the experiment.  The other
two methods bypass the HTML screen and will directly open the MassTracker program with the experiment
file�s parameters.

Method 1 (Includes HTML screen):
1. Connect the balance to the PC system using the interface cable.  Power on the balance.

2. Open the Workroom program.

3. Select the required experiment setup from the list shown in the right side window.  Experiments are identi-
fied by an optional description followed by the file name.

4. At this point the experiment name may be double clicked or the primary launch button  may be

selected.

5. If an HTML viewing application is installed, (such as MS Internet Explorer) an HTML screen will be opened.
If the HTML file has not been previously edited a default MassTracker screen will be displayed.   A smaller
window will also be opened in the upper right that contains a �Launch� and �Cancel� button.

6. After the user reviews the HTML screen the Launch button is selected from the smaller window.  (Note: For
continued reference the HTML screen will remain open even after MassTracker is started.  To view the
HTML file again reduce the size of the MassTracker window.)

7. The MassTracker program will open and the setup parameters contained in the experiment file will be
loaded.  If used the setup strings will be sent to the balance and the text string prompts displayed to the
user.   The name of the experiment setup file will be shown in the upper right of the graph window.

Method 2 (No viewing of the HTML screen):
1. Connect the balance to the PC system using the interface cable.  Power on the balance.

2. Open the MassTracker program.

3. Select File � Setups � Open Setup�

4. An �Open� File window will be shown.  Select the required experiment file.  Select �Open�.

5. The MassTracker program will open and the setup parameters contained in the experiment file will be
loaded.  If used the setup strings will be sent to the balance and the text string prompts displayed to the
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user.   The name of the experiment setup file will be shown in the upper right of the graph window.

Method 3 (No viewing of the HTML screen):

1. Connect the balance to the PC system using the interface cable.  Power on the balance.

2. Locate an experiment file that has been saved in the Windows file system or has been placed on the
Windows Desktop.

3. Double click file name or the file icon.

4. The MassTracker program will open and the setup parameters contained in the experiment file will be
loaded.  If used the setup strings will be sent to the balance and the text string prompts displayed to the
user.   The name of the experiment setup file will be shown in the upper right of the graph window.
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The Workroom Program
The purpose of the Workroom is to select, organize and import preset experiment files.  These experiments can
be created by the user, or examples obtained from Ohaus Corporation. The HTML files displayed by Workroom
can be loaded into a word processor and then customized by the user.

Starting Workroom
Workroom can be opened by clicking on the Icon on the desktop or directly from the MassTracker File menu
under Setups.

Interface Option Window
The first time Workroom is run, an interface option may open.  Refer to MassTracker, paragraph on Connect-
ing the Interface for detailed information.

The Workroom Window
➤
➤

➤

Menu bar
Launch button

Experiment
Folders

➤

Window Divider ➤

In the left window of the Workroom is a list of all of the Experiment folders.  If one of these folders is selected,
a list of the experiments stored in this folder will appear in the right window.  Example files from Ohaus are
included under a folder named Example Files.

Experiment Descriptions
and File names

The Import button or Import from the File menu is used to view/move Setup files saved in a
different location not currently listed.

Clicking Launch button or selecting Launch from the File menu will load the experiment highlighted in
the right window.  This setup file will first load the Ohaus MassTracker HTML screen along with an
additional Launch window.

Workroom

Closes the Workroom program and opens the MassTracker program.
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File Menu
Launch
Used to start the highlighted experiment.

Import
Used to open setup files saved in a different storage location i.e. not in the Workroom Experiments folder.

Exit
Used to exit the Workroom program.

Opening a Setup File
When highlighted, a setup file can be opened in three ways:

1. Select Launch under File menu.

2. Click on Launch button.

3. Double click the file name.

Starting Workroom (Cont.)
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HTML Files
In order to make full use of the Workroom,  you will want to create new or revised HTML files to accompany
the experiment setup files.  HTML files, complete with diagrams, graphics, etc. are based on the worldwide
HTML format.

� From within MassTracker, create a setup using the required experiment parameters.
� Save the setup and enter the setup file description.  A new folder will also be created (with the same file

name) which contains a default Index.html file.  This is the file that you will replace with one of your
own HTML files.

� Exit the MassTracker.
� Load an application that is suitable for creating your own HTML file such as MS Word, MS Publisher or

MS Front Page.  Create or edit existing HTML file.
� In case any editing is needed at a later stage, also save the HTML file in the application�s normal format

e.g. as a Word document.
� Resave the file as Index.html in the folder that has the same name as the setup file.

For example: Select the file type as an HTML document.
Type the file name in as Index.html.
Locate the folder for the setup file.  For example, if the setup file was saved as TEST, the
path to the work sheet folder could be C:\My Documents\MassTracker Experiments\Test.
Open the Test folder and Save to replace the existing default Index.html file.

NOTES 1. Ensure that the file is saved as .html - some versions of Microsoft Word may save as an .htm file, which will then
not work correctly with the Workroom application.

2. Applications used to create HTML files (such as MS Publisher) may create more than just the index.html
file, e.g. pictures, to go on the page that have been saved as GIF or JPG�s.  If this is the case, ensure that ALL of
the files are saved in the same folder.  Also note that some newer HTML editors may not be fully compatible with
the HTML application that displays the files for MassTracker.

� Load the Workroom program.  Select the appropriate folder and the experiment from the list (it will be
listed using the description given during the saving process followed by the file name).

� The HTML file will open together with the Launch window.

Using Prepared HTML Work sheets
Included with MassTracker are examples of some of the prepared HTML files. Other examples may be avail-
able through Ohaus web site ohaus.com.
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NOTES:
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